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Chapter 1. Installing Python

Welcome to Python. Let's dive in. In this chapter, you'll install the version of Python that's right for you.

1.1. Which Python is right for you?

The first thing you need to do with Python is install it. Or do you?

If you're using an account on a hosted server, your ISP may have already installed Python. Most popular Linux
distributions come with Python in the default installation. Mac OS X 10.2 and later includes a command-line version of
Python, although you'll probably want to install a version that includes a more Mac-like graphical interface.

Windows does not come with any version of Python, but don't despair! There are several ways to point-and-click
your way to Python on Windows.

As you can see already, Python runs on a great many operating systems. The full list includes Windows, Mac OS,
Mac OS X, and all varieties of free UNIX-compatible systems like Linux. There are also versions that run on Sun
Solaris, AS/400, Amiga, OS/2, BeOS, and a plethora of other platforms you've probably never even heard of.

What's more, Python programs written on one platform can, with a little care, run on any supported platform. For
instance, [ regularly develop Python programs on Windows and later deploy them on Linux.

So back to the question that started this section, "Which Python is right for you?" The answer is whichever one runs on
the computer you already have.

1.2. Python on Windows

On Windows, you have a couple choices for installing Python.

ActiveState makes a Windows installer for Python called ActivePython, which includes a complete version of Python,
an IDE with a Python-aware code editor, plus some Windows extensions for Python that allow complete access to
Windows-specific services, APIs, and the Windows Registry.

ActivePython is freely downloadable, although it is not open source. It is the IDE I used to learn Python, and I
recommend you try it unless you have a specific reason not to. One such reason might be that ActiveState is generally
several months behind in updating their ActivePython installer when new version of Python are released. If you
absolutely need the latest version of Python and ActivePython is still a version behind as you read this, you'll want to
use the second option for installing Python on Windows.

The second option is the "official" Python installer, distributed by the people who develop Python itself. It is freely
downloadable and open source, and it is always current with the latest version of Python.

Procedure 1.1. Option 1: Installing ActivePython
Here is the procedure for installing ActivePython:
1. Download ActivePython from http://www.activestate.com/Products/ActivePython/.
2. If you are using Windows 95, Windows 98, or Windows ME, you will also need to download and install
Windows Installer 2.0

(http://download.microsoft.ecom/download/WindowslInstaller/Install/2.0/W9XMe/EN-US/InstMsiA.exe)
before installing ActivePython.
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3. Double-click the installer, ActivePython-2 . 2 . 2-224-win32-ix86 .msi.

4. Step through the installer program.

5. If space is tight, you can do a custom installation and deselect the documentation, but I don't recommend this
unless you absolutely can't spare the 14MB.

6. After the installation is complete, close the installer and choose Start->Programs->ActiveState ActivePython
2.2->PythonWin IDE. You'll see something like the following:

PythonWin 2.2.2 (#37, Nov 26 2002, 10:24:37) [MSC 32 bit (Intel)] on win32.
Portions Copyright 1994-2001 Mark Hammond (mhammond@skippinet.com.au) -see
"Help/About PythonWin® for further copyright information. >>>

Procedure 1.2. Option 2: Installing Python from Python.org (http://www.python.org/)

1. Download the latest Python Windows installer by going to http://www.python.org/ftp/python/ and selecting
the highest version number listed, then downloading the . exe installer.

2. Double-click the installer, Python-2 . xxx. yyy. exe. The name will depend on the version of Python
available when you read this.

3. Step through the installer program.

4. If disk space is tight, you can deselect the HTMLHelp file, the utility scripts (Tools/), and/or the test suite
(Lib/test/).

5. If you do not have administrative rights on your machine, you can select Advanced Options, then choose
Non-Admin Install. This just affects where Registry entries and Start menu shortcuts are created.

6. After the installation is complete, close the installer and select Start->Programs->Python 2.3->IDLE (Python
GUI). You'll see something like the following:

Python 2.3.2 (#49, Oct 2 2003, 20:02:00) [MSC v.1200 32 bit (Intel)] on win32

Personal firewall software may warn about the connection IDLE
makes to its subprocess using this computer®s internal loopback
interface. This connection is not visible on any external
interface and no data is sent to or received from the Internet.

IDLE 1.0

1.3. Python on Mac OS X

On Mac OS X, you have two choices for installing Python: install it, or don't install it. You probably want to install it.
Mac OS X 10.2 and later comes with a command-line version of Python preinstalled. If you are comfortable with the
command line, you can use this version for the first third of the book. However, the preinstalled version does not come

with an XML parser, so when you get to the XML chapter, you'll need to install the full version.

Rather than using the preinstalled version, you'll probably want to install the latest version, which also comes with a
graphical interactive shell.

Procedure 1.3. Running the Preinstalled Version of Python on Mac OS X
To use the preinstalled version of Python, follow these steps:
1. Open the /Applications folder.
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2. Open the Utilities folder.
3. Double-click Terminal to open a terminal window and get to a command line.
4. Type python at the command prompt.

Try it out:

Welcome to Darwin!

[localhost:~] you% python Python 2.2

(#1, 07/14/02, 23:25:09)

[GCC Apple cpp-precomp 6.14] on darwin

Type "help™, "copyright', "credits"™, or "license" for more information.
>>> [press Ctrl+D to get back to the command prompt]

[localhost:~] you%

Procedure 1.4. Installing the Latest Version of Python on Mac OS X

Follow these steps to download and install the latest version of Python:

—

. Download the MacPython-OSX disk image from http://homepages.cwi.nl/~jack/macpython/download.html.

. If your browser has not already done so, double-click MacPython-OSX-2 . 3 -1. dmg to mount the disk
image on your desktop.

. Double-click the installer, MacPython-OSX .pkg.

. The installer will prompt you for your administrative username and password.

. Step through the installer program.

. After installation is complete, close the installer and open the /Appl icat ions folder.

. Open the MacPython-2 . 3 folder

. Double-click Python IDE to launch Python.

N

0NN L AW

The MacPython IDE should display a splash screen, then take you to the interactive shell. If the interactive shell does
not appear, select Window->Python Interactive (Cmd-0). The opening window will look something like this:

Python 2.3 (#2, Jul 30 2003, 11:45:28)

[GCC 3.1 20020420 (prerelease)]

Type "copyright”, "credits”™ or "license"” for more information.
MacPython IDE 1.0.1

Note that once you install the latest version, the pre-installed version is still present. If you are running scripts from the
command line, you need to be aware which version of Python you are using.

Example 1.1. Two versions of Python

[localhost:~] you% python Python 2.2

(#1, 07/14/02, 23:25:09)

[GCC Apple cpp-precomp 6.14] on darwin

Type "help', "copyright', "credits", or "license" for more information.
>>> [press Ctrl+D to get back to the command prompt]

[localhost:~] you% /Zusr/local/bin/python

Python 2.3 (#2, Jul 30 2003, 11:45:28)

[GCC 3.1 20020420 (prerelease)] on darwin

Type "help', "copyright', "credits", or "license" for more information.
>>> [press Ctrl+D to get back to the command prompt]

[localhost:~] you%
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1.4. Python on Mac OS 9

Mac OS 9 does not come with any version of Python, but installation is very simple, and there is only one choice.
Follow these steps to install Python on Mac OS 9:

1. Download the MacPython2 3 ful I. bin file from
http://homepages.cwi.nl/~jack/macpython/download.html.

2. If your browser does not decompress the file automatically, double-click MacPython2 3 ful 1. bin to
decompress the file with Stuffit Expander.

. Double-click the installer, MacPython23full.

. Step through the installer program.

. AFter installation is complete, close the installer and open the /Appl icat ions folder.

. Open the Mac Python-OS 9 2. 3 folder.

. Double-click Python IDE to launch Python.

NN L bW

The MacPython IDE should display a splash screen, and then take you to the interactive shell. If the interactive shell
does not appear, select Window->Python Interactive (Cmd-0). You'll see a screen like this:

Python 2.3 (#2, Jul 30 2003, 11:45:28)

[GCC 3.1 20020420 (prerelease)]

Type "copyright”, "credits" or "license" for more information.
MacPython IDE 1.0.1

1.5. Python on Red Hat Linux

Installing under UNIX-compatible operating systems such as Linux is easy if you're willing to install a binary
package. Pre-built binary packages are available for most popular Linux distributions. Or you can always compile
from source.

Download the latest Python RPM by going to http://www.python.org/ftp/python/ and selecting the highest version
number listed, then selecting the rpms / directory within that. Then download the RPM with the highest version
number. You can install it with the rpm command, as shown here:

Example 1.2. Installing on RedHat Linux 9

localhost:~$ su -

Password: [enter your root password]

[root@localhost root]# wget http://python.org/ftp/python/2.3/rpms/redhat-9/python2.3-2.3-5pydotorg.i38
Resolving python.org... done.

Connecting to python.org[194.109.137.226] :80 ... connected.

HTTP request sent, awaiting response... 200 OK Length:

7,495,111 [application/octet-stream]

[root@localhost root]# rpm -Uvh python2.3-2.3-5pydotorg.i386.rpm

Preparing. .. HH A [100%])
1:python2.3 B HHHHHH R [100%]
[root@localhost root]# python ©

Python 2.2.2 (#1, Feb 24 2003, 19:13:11)

[GCC 3.2.2 20030222 (Red Hat Linux 3.2.2-4)] on linux2

Type "help', "copyright', '"credits', or "license" for more information.
>>> [press Ctrl+D to exit]
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Python 2.3 (#1, Sep 12 2003, 10:53:56) [GCC 3.2.2

20030222 (Red Hat Linux 3.2.2-5)] on linux2

Type "help', "copyright'”, "credits"™, or "license"” for more information.
>>> [press Ctrl+D to exit] [root@localhost

root]# which python2.3 ©

/usr/bin/python2.3

®  Whoops! Just typing python gives you the older version of Python — the one that was installed by
default. That's not the one you want.

® At the time of this writing, the newest version is called python2 .3. You'll probably want to change the
path on the first line of the sample scripts to point to the newer version.

O This is the complete path of the newer version of Python that you just installed. Use this on the # ! line
(the first line of each script) to ensure that scripts are running under the latest version of Python, and be
sure to type python2 . 3 to get into the interactive shell.

1.6. Python on Debian GNU/Linux

If you are lucky enough to be running Debian GNU/Linux, you install Python through the apt command.

Example 1.3. Installing on Debian GNU/Linux

localhost:~$ su -
Password: [enter your root password]
localhost:~# apt-get install python
Reading Package Lists. . . Done
Building Dependency Tree... Done
The following extra packages will be installed:
python2.3 Suggested
packages:
python-tk python2.3-doc The following NEW
packages will be installed:
python python2.3
0 upgraded, 2 newly installed, 0 to remove and 3 not upgraded.
Need to get OB/2880kB of archives.
After unpacking 9351kB of additional disk space will be used.
Do you want to continue? [Y/n] Y
Selecting previously deselected package python2.3.

(Reading database ... 22848 files and directories currently installed.)
Unpacking python2.3 (from .../python2.3 2.3.1-1_i386.deb) ... Selecting
previously deselected package python. Unpacking python (from
.../python_2._.3_1-1_all.deb) ... Setting up python (2.3.1-1) ... Setting
up python2.3 (2.3.1-1) ...

Compiling python modules in Zusr/lib/python2.3 ... Compiling

optimized python modules in Zusr/lib/python2.3 ... localhost:~#

exit logout

Python 2.3.1 (#2, Sep 24 2003, 11:39:14) [GCC

3.3.2 20030908 (Debian prerelease)] on linux2

Type "help', "copyright', "credits” or "license"™ for more information.
>>> [press Ctrl+D to exit]

1.7. Python Installation from Source

If you prefer to build from source, you can download the Python source code from http://www.python.org/ftp/python/.
Select the highest version number listed, download the . tgz file), and then do the usual configure, make, make
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install dance.

Example 1.4. Installing from source

localhost:~$ su -
Password: [enter your root password]
localhost:~# wget http://www.python.org/ftp/python/2.3/Python-2.3.tgz

Resolving www.python.org... done.
Connecting to www.python.org[194.109.137.226] :80 ... connected.
HTTP request sent, awaiting response... 200 OK

Length: 8,436,880 [application/x-tar]

localhost:~# tar xfz Python-2.3.tgz
localhost:~# cd Python-2.3
localhost:~/Python-2.3# ./configure
checking MACHDEP... linux2 checking
EXTRAPLATDIR. .. checking for --

localhost:~/Python-2_3# make
gcc -pthread -c -fno-strict-aliasing -DNDEBUG -g -03 -Wall -Wstrict-prototypes

-1. -1./7/Include -DPy_BUILD_CORE -0 Modules/python.o Modules/python.c
gcc -pthread -c -fno-strict-aliasing -DNDEBUG -g -03 -Wall -Wstrict-prototypes
-1. -1_./Include -DPy_BUILD_CORE -o0 Parser/acceler.o Parser/acceler.c
gcc -pthread -c -fno-strict-aliasing -DNDEBUG -g -03 -Wall -Wstrict-prototypes
-1. -1_./Include -DPy_BUILD_CORE -o0 Parser/grammarl.o Parser/grammarl.c

localhost:~/Python-2.3# make install /usr/bin/install

localhost:~/Python-2.3# exit

logout

localhost:~$ which python

/usr/local/bin/python

localhost:~$ python

Python 2.3.1 (#2, Sep 24 2003, 11:39:14) [GCC

3.3.2 20030908 (Debian prerelease)] on linux2

Type "help™, "copyright”, "credits™ or "license" for more information.
>>> [press Ctrl+D to get back to the command prompt] localhost:~$

1.8. The Interactive Shell

Now that you have Python installed, what's this interactive shell thing you're running?

It's like this: Python leads a double life. It's an interpreter for scripts that you can run from the command line or run
like applications, by double-clicking the scripts. But it's also an interactive shell that can evaluate arbitrary statements
and expressions. This is extremely useful for debugging, quick hacking, and testing. I even know some people who
use the Python interactive shell in lieu of a calculator!

Launch the Python interactive shell in whatever way works on your platform, and let's dive in with the steps shown

here:

Example 1.5. First Steps in the Interactive Shell

>>> 1 + 1
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2
>>> print "hello world® ©
hello world

>>x =1 ©
>>>y = 2

>>> X + Yy

3

©  The Python interactive shell can evaluate arbitrary Python expressions, including any basic arithmetic
expression.

©  The interactive shell can execute arbitrary Python statements, including the print statement.

® You can also assign values to variables, and the values will be remembered as long as the shell is open
(but not any longer than that).

1.9. Summary

You should now have a version of Python installed that works for you.
Depending on your platform, you may have more than one version of Python intsalled. If so, you need to be aware of
your paths. If simply typing python on the command line doesn't run the version of Python that you want to use, you

may need to enter the full pathname of your preferred version.

Congratulations, and welcome to Python.
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Chapter 2. Your First Python Program

You know how other books go on and on about programming fundamentals and finally work up to building a
complete, working program? Let's skip all that.

2.1. Diving in
Here is a complete, working Python program.

It probably makes absolutely no sense to you. Don't worry about that, because you're going to dissect it line by line.
But read through it first and see what, if anything, you can make of it.

Example 2.1. odbchelper.py

If you have not already done so, you can download this and other examples
(http://diveintopython.Org/download/diveintopython-examples-5.4.zip) used in this book.

def buildConnectionString(params):
""" Build a connection string from a dictionary of parameters.

Returns string.
return ;" _join( [ "%s = %s™ % (k, v) for k, v in params.itemsQ])

if _name _ =" _main_"
myParams = {"'server”:"mpilgrim”, \
"database":"master™, \
“uid":"sa", \
"pwd":"secret" \
print
bui ldConnectionString(myParams)

Now run this program and see what happens.

In the ActivePython IDE on Windows, you can run the Python program you're editing by choosing File->Run...
(Ctrl-R). Output is displayed in the interactive window.

In the Python IDE on Mac OS, you can run a Python program with Python->Run window... (Cmd-R), but there is

an important option you must set first. Open the . py file in the IDE, pop up the options menu by clicking the black
triangle in the upper-right corner of the window, and make sure the Runas  main__ option is checked. This is a
per-file setting, but you'll only need to do it once per file.

On UNIX-compatible systems (including Mac OS X), you can run a Python program from the command line:
python odbchelper.py

The output of odbchelper .py will look like this:
server=mpilgrim;uid=sa;database=master ;pwd=secret
2.2. Declaring Functions

Python has functions like most other languages, but it does not have separate header files like C++ or
interface/implementation sections like Pascal. When you need a function, just declare it, like this:
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def buildConnectionString(params):

Note that the keyword def starts the function declaration, followed by the function name, followed by the arguments
in parentheses. Multiple arguments (not shown here) are separated with commas.

Also note that the function doesn't define a return datatype. Python functions do not specify the datatype of their
return value; they don't even specify whether or not they return a value. In fact, every Python function returns a value;
if the function ever executes a return statement, it will return that value, otherwise it will return None, the Python
null value.

In Visual Basic, functions (that return a value) start with f unct ion, and subroutines (that do not return a value)
start with sub. There are no subroutines in Python. Everything is a function, all functions return a value (even if it's
None), and all functions start with def.

The argument, params, doesn't specify a datatype. In Python, variables are never explicitly typed. Python figures out
what type a variable is and keeps track of it internally.

In Java, C++, and other statically-typed languages, you must specify the datatype of the function return value and
each function argument. In Python, you never explicitly specify the datatype of anything. Based on what value you
assign, Python keeps track of the datatype internally.

2.2.1. How Python's Datatypes Compare to Other Programming Languages
An erudite reader sent me this explanation of how Python compares to other programming languages:

statically typed language
A language in which types are fixed at compile time. Most statically typed languages enforce this by requiring
you to declare all variables with their datatypes before using them. Java and C are statically typed languages.
dynamically typed language
A language in which types are discovered at execution time; the opposite of statically typed. VBScript and
Python are dynamically typed, because they figure out what type a variable is when you first assign it a value.
strongly typed language
A language in which types are always enforced. Java and Python are strongly typed. If you have an integer, you
can't treat it like a string without explicitly converting it.
weakly typed language
A language in which types may be ignored; the opposite of strongly typed. VBScript is weakly typed. In
VBScript, you can concatenate the string ' 12 ' and the integer 3 to get the string '123", then treat that as the
integer 123, all without any explicit conversion.

So Python is both dynamically typed (because it doesn't use explicit datatype declarations) and strongly typed (because
once a variable has a datatype, it actually matters).

2.3. Documenting Functions

You can document a Python function by giving it a doc st ring.

Example 2.2. Defining the buildConnectionString Function's doc string

def buildConnectionString(params):
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Returns string."""

Triple quotes signify a multi-line string. Everything between the start and end quotes is part of a single string,
including carriage returns and other quote characters. You can use them anywhere, but you'll see them most often used
when defininga doc string.

Triple quotes are also an easy way to define a string with both single and double quotes, like qq/ . . . / in Perl.
Everything between the triple quotes is the function's doc string, which documents what the function does. A doc
string, if it exists, must be the first thing defined in a function (that is, the first thing after the colon). You don't
technically need to give your function a doc string, but you always should. I know you've heard this in every
programming class you've ever taken, but Python gives you an added incentive: the doc string is available at
runtime as an attribute of the function.

Many Python IDEs use the doc string to provide context-sensitive documentation, so that when you type a
function name, its doc string appears as a tooltip. This can be incredibly helpful, but it's only as good as the doc
strings you write. Further Reading on Documenting Functions

* PEP 257 (http://www.python.org/peps/pep-0257.html) defines doc string conventions.

+ Python Style Guide (http://www.python.org/doc/essays/styleguide.html) discusses how to write a good doc
string.

= Python Tutorial (http://www.python.org/doc/current/tut/tut.html) discusses conventions for spacing in doc
strings (http://www.python.org/doc/current/tut/node6.htmI#SECTION006750000000000000000).

2.4. Everything Is an Object

In case you missed it, I just said that Python functions have attributes, and that those attributes are available at
runtime.

A function, like everything else in Python, is an object.

Open your favorite Python IDE and follow along:

Example 2.3. Accessing the buildConnectionString Function’s doc string

>>> import odbchelper ©

>>> params = {"server':"mpilgrim"”, "database'":"master", "uid":"sa', "'pwd'":"secret'}
>>> print odbchelper.buildConnectionString(params) ©
server=mpilgrim;uid=sa;database=master ;pwd=secret

>>> print odbchelper._buildConnectionString.__doc__ ©

Build a connection string from a dictionary

Returns string.

©  The first line imports the odbchelper program as a module — a chunk of code that you can use
interactively, or from a larger Python program. (You'll see examples of multi-module Python programs in
Chapter 4.) Once you import a module, you can reference any of its public functions, classes, or attributes.
Modules can do this to access functionality in other modules, and you can do it in the IDE too. This is an
important concept, and you'll talk more about it later.
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©  When you want to use functions defined in imported modules, you need to include the module name. So you
can't just say buildConnectionString; it must be odbchelper .buildConnectionString. If
you've used classes in Java, this should feel vaguely familiar.

® Instead of calling the function as you would expect to, you asked for one of the function's attributes,  doc

import in Python is like require in Perl. Once you import a Python module, you access its functions with
module. function; once you require a Perl module, you access its functions with module: : function.

2.4.1. The Import Search Path

Before you go any further, I want to briefly mention the library search path. Python looks in several places when you
try to import a module. Specifically, it looks in all the directories defined in sys . path. This is just a list, and you
can easily view it or modify it with standard list methods. (You'll learn more about lists later in this chapter.)

Example 2.4. Import Search Path

>>> import Sys O

>>> sys.path ©

[F", "/usr/local/lib/python2.2", “/usr/local/lib/python2.2/plat-Iinux2-”,
t/usr/local/lib/python2.2/1ib-dynload', "/usr/local/lib/python2.2/site-packages”,

>>> sys ©
<module "sys® (built-in)>
>>> sys._path.append(*/my/new/path®) O

V  Importing the sys module makes all of its functions and attributes available.

©  sys. pathis a list of directory names that constitute the current search path. (Yours will look different,
depending on your operating system, what version of Python you're running, and where it was originally
installed.) Python will look through these directories (in this order) for a . py file matching the module name
you're trying to import.

®  Actually, I lied; the truth is more complicated than that, because not all modules are stored as . py files. Some,
like the sys module, are "built-in modules"; they are actually baked right into Python itself. Built-in modules
behave just like regular modules, but their Python source code is not available, because they are not written in
Python! (The sys module is written in C.)

®  You can add a new directory to Python's search path at runtime by appending the directory name to
sys . path, and then Python will look in that directory as well, whenever you try to import a module. The
effect lasts as long as Python is running. (You'll talk more about append and other list methods in Chapter 3.)

2.4.2. What's an Object?

Everything in Python is an object, and almost everything has attributes and methods. All functions have a built-in
attribute ~ doc__, which returns the doc string defined in the function's source code. The sys module is an
object which has (among other things) an attribute called path. And so forth.

Still, this begs the question. What is an object? Different programming languages define "object" in different ways. In
some, it means that all objects must have attributes and methods; in others, it means that all objects are subclassable.
In Python, the definition is looser; some objects have neither attributes nor methods (more on this in Chapter 3), and
not all objects are subclassable (more on this in Chapter 5). But everything is an object in the sense that it can be
assigned to a variable or passed as an argument to a function (more in this in Chapter 4).

This is so important that I'm going to repeat it in case you missed it the first few times: everything in Python is an
object. Strings are objects. Lists are objects. Functions are objects. Even modules are objects.
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Further Reading on Obijects

* Python Reference Manual (http://www.python.org/doc/current/ref/) explains exactly what it means to say that
everything in Python is an object (http://www.python.org/doc/current/ref/objects.html), because some people
are pedantic and like to discuss this sort of thing at great length.

« eff-bot (http://www.effbot.org/guides/) summarizes Python objects
(http://www.effbot.org/guides/python-objects.htm).

2.5. Indenting Code

Python functions have no explicit begin or end, and no curly braces to mark where the function code starts and
stops. The only delimiter is a colon (:) and the indentation of the code itself.

Example 2.5. Indenting the buildConnectionString Function

def buildConnectionString(params):
""" Build a connection string from a dictionary of parameters.

Returns string.
return ;" _join(C [ "%s = %s" % (k, v) for k, v in params.itemsQ1)

Code blocks are defined by their indentation. By "code block"”, I mean functions, if statements, for loops, while
loops, and so forth. Indenting starts a block and unindenting ends it. There are no explicit braces, brackets, or
keywords. This means that whitespace is significant, and must be consistent. In this example, the function code
(including the doc string) is indented four spaces. It doesn't need to be four spaces, it just needs to be consistent.
The first line that is not indented is outside the function.

Example 2.6, ~if Statements” shows an example of code indentation with if statements.

Example 2.6. i f Statements

def Fib(n): 0
print "n =", n ©
ifn>1: €

return n * fib(n - 1)
else: 0

print "end of the line"

This is a function named f ib that takes one argument, n. All the code within the function is indented.

e

Printing to the screen is very easy in Python, just use print. print statements can take any data
type, including strings, integers, and other native types like dictionaries and lists that you'll learn about
in the next chapter. You can even mix and match to print several things on one line by using a
comma-separated list of values. Each value is printed on the same line, separated by spaces (the
commas don't print). So when fib is called with 5, this will print "n = 5".

€  if statements are a type of code block. If the if expression evaluates to true, the indented block is
executed, otherwise it falls to the else block.

€  Of course if and else blocks can contain multiple lines, as long as they are all indented the same
amount. This else block has two lines of code in it. There is no other special syntax for multi-line
code blocks. Just indent and get on with your life.
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After some initial protests and several snide analogies to Fortran, you will make peace with this and start seeing its
benefits. One major benefit is that all Python programs look similar, since indentation is a language requirement and
not a matter of style. This makes it easier to read and understand other people's Python code.

Python uses carriage returns to separate statements and a colon and indentation to separate code blocks. C++ and
Java use semicolons to separate statements and curly braces to separate code blocks. Further Reading on Code
Indentation

* Python Reference Manual (http://www.python.org/doc/current/ref/) discusses cross-platform indentation
issues and shows various indentation errors (http://www.python.org/doc/current/ref/indentation.html).
* Python Style Guide (http://www.python.org/doc/essays/styleguide.html) discusses good indentation style.

2.6. Testing Modules

Python modules are objects and have several useful attributes. You can use this to easily test your modules as you
write them. Here's an example that uses the i f _ name__ trick.

" "

if name =" main_":
Some quick observations before you get to the good stuff. First, parentheses are not required around the i f
expression. Second, the if statement ends with a colon, and is followed by indented code.

Like C, Python uses == for comparison and = for assignment. Unlike C, Python does not support in-line assignment,
so there's no chance of accidentally assigning the value you thought you were comparing.

So why is this particular if statement a trick? Modules are objects, and all modules have a built-in attribute
__name__ .Amodule's name _ depends on how you're using the module. If you import the module, then
__name__is the module's filename, without a directory path or file extension. But you can also run the module
directly as a standalone program, in which case _ name _ will be a special default value, _ main _

>>> import odbchelper
>>> odbchelper.__name _
*odbchelper”

Knowing this, you can design a test suite for your module within the module itself by putting it in this i f statement.
When you run the module directly, ~name is  main _, so the test suite executes. When you import the
module, name _ is something else, so the test suite is ignored. This makes it easier to develop and debug new
modules before integrating them into a larger program.

On MacPython, there is an additional step to make theif  name _ trick work. Pop up the module's options menu
by clicking the black triangle in the upper-right corner of the window, and make sure Run as __main__is checked.
Further Reading on Importing Modules

* Python Reference Manual (http://www.python.org/doc/current/ref/) discusses the low-level details of
importing modules (http://www.python.org/doc/current/ref/import.html).
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